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WARRANTY 
Z Technology Inc. warrants to its Customers that the products it manufactures and sells will be free from defects 
in materials and workmanship for a period of one (1) year from the date of delivery. If any such product proves 
defective during the application warranty period, Z Technology Inc. at it’ s option, either will repair the defective 
product without charge for parts and labor or will provide a replacement in exchange for the defective product. 

In order to obtain service under this warranty, Customer must notify Z Technology Inc. of the defect before the 
expiration of the warranty period and make suitable arrangements for the performance of service. Z Technology 
Inc. will provide such service at its headquarters or at one of its authorized service centers. Customer shall be 
responsible for all taxes, duties, packaging, shipping and insuring of the defective product to the service center 
designated by Z Technology Inc. with all these expenses prepaid. Z Technology Inc. shall pay for return 
shipping to Customer at the same location from which the product was shipped. 

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate 
maintenance and care. Z Technology Inc. shall not be obligated to furnish service under this warranty a) to repair 
damage resulting from attempts by personnel other than Z Technology Inc. representatives to install, repair or 
service the product; or b) to repair damage resulting from improper use or connection to incompatible 
equipment. 

THIS WARRANTY IS GIVEN BY Z TECHNOLOGY INC. IN L IEU OF ANY OTHER WARRANTIES, 
EXPRESSED OR IMPLIED.  Z TECHNOLOGY INC. AND ITS VENDORS DISCLAIM ANY 
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
Z TECHNOLOGY INC.' RESPONSIBIL ITY TO REPAIR OR REPLACE A DEFECTIVE PRODUCT 
IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF 
THE WARRANTY.  Z TECHNOLOGY INC. AND ITS VENDORS WILL NOT BE LIABLE FOR ANY 
INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, IRRESPECTIVE OF 
WHETHER Z TECHNOLOGY INC. OR THE VENDOR HAS ADVANCE NOTICE OF THE 
POSSIBIL ITY OF SUCH DAMAGES. 
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Section 1: Specifications 
DM1010 Specifications 

Parameter Specification 

RF Input  

Channel 2 – 69 54 - 806 MHz System M channel plan 

Impedance 50 ohm, Type N 

Return Loss 14 dB or better 

Signal Level Range 0 dBm to -70 dBm, integrated power over 
6MHz bandwidth 

Signal Level Accuracy ± 2 dB traceable to NIST 

6 MHz Bandpass Flatness ± 1 dB 

Preamplifier Noise Figure 7.3 dB  

RF System Phase Noise <-90 dBc/Hz @ 20 kHz offset 

Group Delay <10 nS over 6 MHz 

TOIP +20 dBm for all AGC and Amplifier Settings 

IF Input  

44 MHz ±3 MHz Same input connector as RF Input. Signal 
orientation requires high-side pilot. See 
Options Menu within WinDM ProÔ  for 
decoding of low-side pilot IF signal. 

Impedance 50 ohm, Type N 

Signal Range -70dBm to - 0dBm 

Return Loss 20 dB or better 

Outputs  

High IF 44 MHz center freq., 50 ohm, Type BNC,  
-10 to –25 dBm nominal 

Low IF 4 MHz center freq. 50 ohm, Type BNC,  
-5 to –20dBm nominal 

Ch 7/8 High Power 50 ohm, Type BNC, -5 to -20 dBm nominal 
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Parameter Specification 

Ch 7/8 Low Power 75 ohm, Type F, -25 to –40 dBm nominal 

Transport Stream, SPI 8-bit wide LVDS MPEG2 (ATSC-compliant), D-
sub-25 connector, female 

Transport Stream, SSI Serial SMPTE 310M, 75 ohm, 19.39 Mbps,  
BNC Connector, 800mV p-p ± 10% 

Transport Stream, ASI Asynchronous serial Interface, 270 Mbps, 75 
ohm, BNC connector, 800mV p-p ± 10% 

Transport Stream  

Performance The Transport Stream PLL removes all the 
arrival-time jitter above 2Hz (PLL BW). The SSI 
jitter is essentially all due to PCR accuracy 
errors encoded at the source. The ASI will also 
measure the same but with about 37nsec more 
jitter due to the ASI interface 

Decoder Performance  

Adaptive Equalizer Feed forward error correction decoder (DFE) 
Equalizer Range: -2.3 uS to +22.5 uS. Using 
external software, static echoes up to 80 uS 
can be displayed. Equalization based on ATSC 
field sync (trained) and/or 8VSB data (blind) 
Trellis (Viterbi) decoder Rate 2/3 (Rate 1/2 
Underboeck code based) 

VSB Nyquist Filtering Nyquist slope generated digitally 

Computer Interface Customer supplied PC 

  

Remote interface Serial Port, D-sub-9 female connector or 
10BaseT/100BaseT Ethernet 

Application type Priority WindowsÒ, WinDM ProÔ  applications 
provided with instrument. 

Instrument settings under PC control All controls and displays are accessable from 
user supplied PF running WinDM ProÔ .  
Instrument settings under PC control include 
the following: 

 Channel Select 
 RF/IF input 
 Gain AGC or Manual 
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Parameter Specification 

 Data recording 
 Event Logging 
 Analysis/ Transport Stream mode 
 Channel 7/8 output 
 Front Panel Security lock/unlock 

Software  

Media WinDM ProÔ  and Snag-ItÔ  application 
supplied on CD 

Operating System Windows 98Ò Second Edition 
Windows XPÒ Home or Professional 

Time Plot parameters displayed by PC RF Input Power Level, Sync Lock, EQ Lock, 
TOV, Dynamic Tap Energy (TE), Signal to 
Noise ratio (SNR) (HW Equalized), Error 
Vector Magnitude (EVM) (HW Equalized), 
Segment Error Rate (SER), AGC Voltage, SNR 
SW Equalized, EVM SW Equalized, MER SW 
Equalized 

Tap parameters displayed by PC Tap Energy (-2.3 to +10, 22, 46, or 80 uS) 
Spectrum Display, Constellation Display, Eye 
Pattern Display 

Spectrum Plot parameters displayed by PC Horizontal Frequency Span: 10MHz & 18MHz, 
Averaging of 1, 4, 8, 16, 32 samples, 
FCC Mask overlay, Pilot overlay, Adjacent 
NTSC Ch On/Off, ATSC On/Off, Video filter 
On/Off and Clear Plot 

Constellation Plot parameters displayed by PC Captures of 1, 2, 4, 8,16 superimposed, 
Overlays of Ideal I Values, 
Decision Boxes, 
both 2-level Field Segment Sync and full 8-
level Constellation display with and without SW 
Equalization. 

Eye Pattern parameters displayed by PC 2-Symbol Expanded plot with interpolation of 
Linear or SineX/X with and without SW 
Equalization, 
Overlays for Ideal I Values and Decision boxes, 
both 2-level Field Segment Sync and full 8-
level Eye Pattern display with and without SW 
Equalization. 

Status Indication RF Input Level in dBm, Sync Lock, Equalizer 
Lock, TOV, Data Recording On/Off, Transport 
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Parameter Specification 

Stream On/Off, Communication 

Physical characteristics  

Size and Weight 19” wide, 17” deep, 3.5” high, 13 lbs 

Mains supply 90-240 Vac, 30 VA, 50-60 Hz. 

Note: all specifications reflect typical values. 
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Section 2: DM1010 Product Overview 
DM1010 Front View 

 

Overview 

The DM1010 is a precision ATSC-compliant 8VSB demodulator for reception, monitoring, 
measurement and documentation of North American System-M (channels 2 – 69) terrestrial television 
signals. It is designed to provide low-distortion DTV reception thus permitting accurate analysis of 
critical RF and data parameters of terrestrial television signals. A wide dynamic range RF front-end 
with excellent Third Order Intercept Point (TOIP) and good noise figure all combine to allow reception 
at difficult off-air studio or translator locations. The system has excellent immunity with auto-ranging 
input discrete attenuators that maintain signal path integrity for use in off-air locations or at the most 
demanding sites such as directly connected to the RF signal path at the transmitter plant. 

A received DTV signal can be evaluated for RF degradations that may affect a viewer’s ability to 
receive the signal. Such distortions include 8VSB sync and equalizer decoder lock capability, effects 
due to multi-path, signal-to-noise ratio, threshold of visibility, segment error rate and calibrated 
received power level variations. The product is provided with its WinDM ProÔ  Windows™ application 
software to facilitate real-time analysis while RF and data figures of merit are recorded into clear-text 
data history files for later analysis. 

Dynamic graphs of available transmission parameters include Dynamic TAP Energy, RF Spectrum, 
Constellation, and Eye Pattern. 

In addition to measuring and tracking signal parameters, the DM1010 provides SMPTE 310M, ASI and 
LVDS transport stream outputs for data analysis, and an ATSC/8VSB signal is provided on vhf 
channel seven or eight for distribution to DTV receivers throughout the plant. 

The DM1010 is a carefully designed and calibrated system consisting of an instrumentation-type rack-
mount package, powered from 120VAC power mains and ready to rack-mount installation. The system 
is well suited for studio or transmitter plant applications or installation at a remote receiver site. 

Operation of the DM1010 can be from the instrument’s front panel or from a PC connected to the 
DM1010 through a WindowsÒ application named WinDM ProÔ . Connection between a PC and the 
DM1010 is made through a standard RS-232 type serial port. The DM1010 can also be controlled 
through an Ethernet connection using standard network protocols. 
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Features 

Key performance features of the DM1010. 

¨  An instrument grade ATSC 8VSB demodulator. 
¨  Operates from low-level off-air signals or high-level inputs from a transmitter tap point. 
¨  ATSC 8VSB transport stream demodulation. 
¨  Effective for use at both fixed transmitter and studio location. 
¨  Tunes all U.S. off-air channels from Ch: 2 through 69. 
¨  Measurement quality design and performance. 
¨  Monitors and records DTV Quality-of-Service metrics. 
¨  MPEG2 Transport Stream outputs in three formats, ASI, SSI (SMPTE310M), SPI (LVDS 

Parallel). 
¨  Constellation, Eye Pattern, RF Spectrum Display. 
¨  Supplied with control, monitoring and recording Windows�  WinDMPro Application. 

 

The Z Technology DM1010 is a reference quality 8VSB digital television demodulator for professional 
broadcast and laboratory applications. This demodulator’s excellent RF performance and wide 
dynamic range allows accurate evaluation of both off-air and high level ATSC DTV signals. 

The DM1010 is built on a rugged instrumentation rack mount platform suitable for use in studio or 
transmitter locations or installation at a remote receiver site. This demodulator utilizes an RF front-end 
designed for true instrumentation performance. Its phase noise performance and frequency stability 
over the television spectrum are outstanding. The design minimizes internal distortions so 
transmission distortions can be accurately analyzed. 

This demodulator can be installed at a transmitter site as part of a corrective feedback loop around a 
high-power transmitter or can be used as a stand-alone instrument for off-air reception of an 8VSB 
modulated DTV signal. 
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DM1010 Rear Panel 

 

DM1010 Rear Panel connectors from left to right 

¨  RF Input ( 0 to –70dBm), channels 2 to 69 or IF Input 44MHz. 
¨  Transport Stream outputs, ASI (270Mb/s), SSI (SMPTE-310M) and SPI (LVDS). 
¨  Low power output (-25 to -40 dBm) channel 7 or 8, 8-VSB signal to drive a local cable 

distribution system, F connector. 
¨  High power output (-5 to –20 dBm) channel 7 or 8, 8-VSB signal for laboratory testing 

purposes, BNC connector. 
¨  44 MHz IF output, BNC connector (inverted, high side pilot). 
¨  44MHz IF input, Type N connector. 

Note: The Type N RF Input connector serves a dual purpose; an RF Input for channels 2 
through 69 or a 44MHz IF input port. In IF mode the normal operating format is for the IF 
input signal to be non-inverted. An inverted IF signal can be decoded to a Transport Stream 
even though most other measurement parameters are not available in this mode. See the Tool 
Options selection within WinDM ProÔ   for more details. 

¨  4 MHz output for laboratory testing, BNC connector (inverted, high side pilot). 
¨  Constellation output consisting of real-time I and Q signals with a scope trigger on the Z Axis 

Output. 
Note: The rear panel real-time I signal output is labeled Y/I and the real-time Q signal is 
labeled X/Q. In most cases, to eliminate any potential confusion, focus on the “ I”  & “Q”  
nomenclature and disregard the “X”  & “Y”  labels. This is especially true when using a real 
time scope to display a Constellation. 

¨  Ethernet for 10/100-base T network interface to communicate with the DM1010. 
¨  Serial I/O (RS-232) interface to communicate with the DM1010. 
¨  Power switch and AC mains input. 
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Real Time Constellation Display 

The DM1010 provides rear panel Real Time outputs from the internal Constellation board along with a 
scope trigger. A scope can trigger on either the segment sync or field sync provided on the Z Output 
connector. Using a wide bandwidth X/Y scope connected to these outputs, the following display are 
available. 

 

Real Time I output versus 
Time triggering on the 
equalizer sync trigger signal 
from the Z Output 
connector. A Field sync 
trigger is also provided on 
the rear panel Z output 
connector. 

 

Real Time Constellation 
display using a wide 
bandwidth scope in X/Y 
mode. 
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WinDM ProÔ  features consist of – 

¨  Full operation of the DM1010 Precision Demodulator. 
¨  Plotting of many 8-VSB RF Decoder parameters. 
¨  Selections of Transport Stream Mode or Analysis Mode. 
¨  Selections of Channel 7 or 8 output frequency. 
¨  Recording of multiple 8-VSB parameters such as SNR, average tap energy, segment error rate, 

and mean square error. 
¨  Recording of several RF parameters such as channel number, frequency, power level, AGC 

voltage and attenuation plus date and time. 
¨  Channel selection with center channel frequency display. 
¨  Selections of Automatic or Manual gain control. 
¨  Display and recording of RF Input power level. 
¨  Dynamic Time Graphing of nine parameters including RF Input Power,  
¨  Dynamic Graphing of Tap energy over 10, 22, 46 or 80 uS. 
¨  Dynamic Graphing of Spectrum Display with two bandwidths of 10MHz and 18 MHz plus a 

Pilot Span. 
¨  Dynamic Graphing of Constellation Display both 2-level Field Segment Sync and full 8-level 

Constellation plot with and without SW Equalization. 
¨  Dynamic Graphing of Eye Pattern Display both 2-level Field Segment Sync and full 8-level 

Eye Pattern plot with and without SW Equalization. 
¨  Configuration or Analysis or Transport Mode. 

DM1010 Local Front Panel Operation 

Local operation of the DM1010 is provided by the front panel controls consisting of three buttons for 
menu selection, Channel knob to change received channel and make menu selections, four status 
indicator lights and the front panel display. 

 

Figure 1: DM1010 Font Panel 
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Shown in Figure 1 is the front panel with the DM1010 tuned to an off-air signal, channel 46 as shown 
in the display. Below the channel number is the center frequency of 665MHz with a zero offset. The 
right side of the display is the Signal to Noise Ration (SNR) of 25.2dB. Below the SNR is the Error 
Vector Magnitude (EVM) of 5.1%.  Below EVM is Segment Error Rate (SER) of zero. Below SER is 
Tap Energy (TE) of –14.4dB. At the bottom of the display is a relative power indicator bar graph with 
the actual input power displayed as –63.8dBm. At the top of the display are several abbreviated 
indicators. From left to right is REMote, RF output channel (Ch7), Transport Stream off (TS-), Gain at 
0dB (Ga 0dB), RF Amplifier on (A+). 

Top display notations  

REM, LOC, FRE Remote: Controlled by a remote source. 

Local: Controlled locally by the front panel. 

Free: Either local or remote control can take control. If local or remote is 
not active for a period of time, FRE will be displayed. 

Ch7 or Ch8 Indicates the RF Output Channel number, either Channel 7 or 8. 

TS- or TS+ If the Transport Stream is off (TS-) the DM1010 is in Analysis mode and 
there is no transport stream available from the rear panel connectors. If the 
Transport Stream is on (TS+) the transport stream is available from the rear 
panel connectors. 

Ga 0, 10, 20, 30, 40, 
50, 60dB 

Indicates the internal step attenuator setting from 0 to 60dB in 10dB steps. 

Ga indicates Gain is automatically set.  Gm indicates Gain is manually set. 

A++ or A+ - 
or 
A -+ or A- - 

The “A” refers to Amplification including the RF Amplifier and IF Amplifier. 
The first character following the “A” indicates the status of the RF Amplifier 
as + meaning ON or – as Off.  

The second character following the “A” indicates the status of the IF 
Amplifier gain as + meaning Hi or – as Low. 

Below the display are three lights to indicate the status of the 8-VSB decoder. The left light indicates 
Sync Lock when lit, the center light indicates Equalizer lock when lit, and the right light indicates the 
signal quality is above the Threshold Of Visibility (TOV) to provide a decodable signal. 

To the right of the display are three buttons to change the display and provide menus to change 
parameters of the DM1010. The use of these buttons will be discussed shortly. 

To the right of the three buttons is the large knob. This knob serves two purposes: selection of a 
channel and menu selections. 

Menu Operation 

The Menu button will cycle through the four menus. Each menu has several items selected by turning 
the large knob. Selection is indicated with the display cursor. With the desired menu item selected, 
press the Select button then turn the Channel knob either direction to make the change to the 
selection. When the desired change is visible, press the Select button to activate the change. Press 
the Cancel button to back out of an operation or to exit all menus. [Note: In some cases only one (1) 
setting can be selected from the front panel. This is the case for the Remote Settings Menu item titled 
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Control. In this case, Local is only front panel setting available. Pushing the Select button twice will 
place the instrument into Local or front-panel operating mode.] 

Main Menu 

 

Main menu: Displayed during normal operation of 
the DM1010. 

Remote Settings Menu 

 

 

Remote Menu: The first configuration menu. 

This menu provides configuration for setting: 

·  Control (Local) 

·  RS232 baud rate (48K, 96K, 38K, 56K) 

·  RS232 flow control (Hardware or None) 

·  DTR (Disabled/Enabled) 

·  Defaults: 

Baud = 56K 
Flow = Hardware 

Note: When communicating with the unit via the 
network connection some features are fully 
functional only when Flow is set to None. 
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Input Settings Menu 

 

 

 

Input Menu: The second configuration menu. 

This menu provides configuration for setting: 

·  Gain to auto or manual1 

·  Attenuation 0 to 60dB in 10dB steps 

·  RF Amplifier On or Off 

·  Tuning to RF Channel, IF, or IF Inverted 

·  Selection of Channel Plan 
1Gain, Attenuation & RF Amp can only be changed if 
in Manual. When Gain is in Auto, attenuation and RF 
Amplifier will be italicized. 

Decoder Settings Menu 

 

Decoder Menu: The third configuration menu. 

This menu provides configuration for setting: 

·  Transport stream On or Off 

·  Taps span to 10, 20, 40 or 80uS 

·  NTSC Co-channel filter Yes/No 
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Instrument Settings Menu 

 

 

Instrument Menu: The forth configuration menu. 

This menu provides configuration for setting: 

·  Locking or unlocking the front panel1 

·  Minimum loss pad either Yes or No2 

·  Power units either dBm or dBuV2 

·  Offset power either Yes or No2 

·  Power offset2 

·  Monitor channel either Ch 7 or Ch 8 
1When locked the channel knob will do nothing. 

2See Section 5: Technical Information for further 
information under the heading Instrument Settings. 

Note 1: If the DM1010 is being used in a critical situation, it is best to lock the front panel so that an 
inadvertent knob twist will not upset the operation. If the knob is turned when the front panel is locked, 
the display will indicate it is locked and provide instructions to unlock the front panel. 

TAPS Display 

The TAPS display is accessible when the Main Menu is displayed by pressing the Select button once. 
Press Cancel to exit this display. 

 

TAPS display when Transport Stream is enabled. 

 

TAPS display when Transport Stream is disabled. 
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Status Menu 

The status menu is accessible when the Main Menu is displayed by pressing the Select button twice. 
Press Cancel to exit this display. 

 

First part of Status Menu 

 

Last part of Status Menu 

Note: Group, Name and  Location can be set using the Edit Instrument Data selection within WinDM 
ProÔ . See the Tools Menu ®  Edit Instrument Data. 

 

DM1010 Defaults 

The default settings for a DM1010 as delivered from the factory are- 

Tuned to Ch-14, Ethernet configured for DHCP. 

[Input Settings] 

Gain = Auto 

Tuning = RF (channel) 

Chan plan = USA-M 

[Decoder settings] 

TStream = ON 

Taps Span = 10uS 

NTSC Cochan = NO 

[Instrument Settings] 

FP Lock = Unlocked 

Min Loss Pad = NO 

Pwr Units = dBm 

Offset Pwr = NO 

PWR Offset = 0 

Mon chan = 7 

[Remote Settings] 

Control = Free 

Baud = 56K 

Flow = Hardware 
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Section 3: WinDM Pro 
The DM1010 operates under the control of a WindowsÒ based PC. The accompanying WindowsÒ 
application, WinDM ProÔ , provides full operation and plotting of various parameters of the received 
signal. 

Using WinDM ProÔÔÔÔ  Release 3 

This section provides information on how to use WinDM ProÔ . 

Tool Tips Note   

While using much of the WinDM ProÔ  Application, Tool Tips will be available to the 
user. A Tool Tip is a short bit of information about various portions of the WinDM 
ProÔ  program. By placing the cursor over many of the dialog boxes, buttons, and 
icons, a tool tip will appear. A Tool Tip is an aide to using the software application. 

 

Start WinDM ProÔ  by selecting Start ®  All Programs ®  Z Technology ®  WinDM Pro. 

When WinDM ProÔ  is first started, the following screen appears. 

        

 

An initialization screen will follow this display. It will look similar to the screen shown as Figure 2 below. 
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Initial Screen 

 

Figure 2: WinDM ProÔÔÔÔ first time star t-up 

Port Selection 

A choice to the user is presented as to the desired connection interface. Make the correct choice for your 
situation by clicking the proper radio button.  The choices are Serial Port or Network. Upon a successful 
connection the instrument name, serial number, channel number and channel center frequency of the 
connected DM1010 are displayed (See Figure 3). Note: Instrument data can be changed through a menu 
selection, which is discussed later in this manual. 

Serial Port Connection 

If Serial Port is chosen, the user must choose from the presented available closed ports. Factory default 
for Baud Rate is 56K and Hardware Handshaking. Select the Connect button when finished. 
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Automatic Network Connection 

If Network is chosen, a valid IP address must be entered into the presented dialog box. The DM1010 is 
factory delivered for automatic IP address assignment from a DHCP server. If the DM1010 is turned on 
with a network cable attached to your network, check the assigned IP address on the front of your 
DM1010. To see the assigned IP address, press the DM1010 front panel Select button twice. Turn the 
Channel knob until the IP Address is displayed. The IP Address will be in the correct subnet range for your 
specific network if the DHCP server assigned the address. If no address is assigned, the front panel IP 
Address will start with 169.254.X.X where X.X can be any valid number. Enter each of the four sets 
(octets) of numbers into the dialog box and press the Connect button. Note: The default port number is 
10001. 

A Previous Connections tab is provided for each successful connection that can be used on subsequent 
connections. Each entry in the Previous Connections list is based on the connected DM1010 serial 
number. If a Serial and network connection is made to the same DM1010, only the last connection will be 
saved in the list. WinDM ProÔ  will always try to connect to the last known good connection first. If a 
connection is not possible, the Connect dialog will appear. 

Manual Network Connection 

If a DHCP server is not available or you need to set a specific IP address for your DM1010, use the tool 
provided on the installation CD in the tools directory under Device Installer. See Section 5, DM1010 Fixed 
IP Address Assignment for specific instructions. 

 

First Time Operation 

With a PC connected and communicating with your DM1010 for the first time, a user will see the WinDM 
ProÔ  start screen shown below.  
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Figure 3: First time operation 

 

At this point, there are several areas of this screen that will be discussed.  Each area is covered in detail 
later in the manual. The objective here is to give the user a general overview of the WinDM ProÔ  screen 
areas regarding use for report, control and display information. 
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Listed in this table are names and uses for the various sections of the start screen. 

Input 
Control 
Panel 

Main WinDM ProÔ  

Plot Screen Window  

Menu Bar & 

Tool Bar  

 

Status Indicator 
Panel 

Active Cursor & 
Figures of Merit 

Panels  

 
 

   

 

 

 

Input and 
Graph 
Control 
Panels are 
accessed 
using the 
tabs at the 
top of this 
area. 

The main WinDM ProÔ interactive 
screen.  The top line, in blue text  
reports data read from the DM1010 
as it communicates with the 
Application. This line can include 
user-selected information but 
normally reports items such as 
instrument name, serial number, 
Channel and frequency of 
operation. Below the graphs appear 
Tabs for accessing other graphs, 
plots & parameters. 

Menu Bar and Tool 
Bar are at the top of 
the screen. They give 
the user ready 
access and control to 
most of the features 
of the Application. 

The Status 
Panel is active 
and visible 
during all normal 
operating 
modes. It 
reports the 
status of several 
critical operating 
parameters.  

The Active 
Cursor panel 
shows 
measurements 
at Cursor 
locations. The 
Figures of Merit 
(FOM) panel 
shows FOM 
values for the 
decoded signal. 

Use this 
panel to set 
received 
Channel #. 
The area 
also reports 
ongoing 
AGC 
activity or 
allows user 
to control 
instrument 
gain 
manually.  

By selecting the various Tabs, 
these Graphical areas can be 
viewed:  

Time Plots 

Taps or Echo Profile 

Spectrum Plots 

Constellation Plots 

Eye Pattern Plots 

See later discussions 
of each Menu and 
Tool Bar selection. 

Status Values 
Reported:  

RF Input Power, 

Signal Level, 
Sync Lock,   EQ 
Lock, TOV, Data 
Recording 
On/Off, 
Transport 
Stream On/Off, 
PC 
Communication 
Rcv/Trans/None 

Figures of 
Merit:  

SNR, EVM, 
MER, Tap 
Energy, AGC 
voltage, etc. 



 Section 3: WinDM Pro 
  

DM1010 User Manual Page 3-6 

The first time WinDM ProÔ is started, the display will be full screen showing a Time Plot which will be 
graphing RF Power. The Input tab Control Panel will be active. The instrument will be tuned to the channel 
the DM1010 hardware was set to after it was powered on and before communications to the PC was 
initialized. Also for first time operation, the Transport Stream will be unselected and the instrument will be 
in Analysis Mode. 

With communication established a DM1010 serial number and channel number will appear above the 
center graph area in blue text. A Tool Tip is available to indicate the connection method by hovering the 
cursor over the DM1010 serial number. The Tool Tip will be “Network (IP address)” for a network 
connection or “RS232 (Com number)” for a serial connection. Data should start to be plotted on the 
selected graph in the center of the WinDM ProÔ  screen. 

WinDM ProÔ  is structured in such a way that the application will not change hardware settings during the 
connection process. All instrument settings will be interrogated and correctly reflected on the WinDM ProÔ  
screen. The DM1010 hardware will only be changed after successful connection to the instrument and the 
user causing a set of actions requesting a change in instrument settings.  

With the PC connected and communicating with the DM1010, the Communication indicator on the right 
Status Panel area will be green and show communication activity of Receiving or Transmitting. These 
terms relate to connection with the PC. If the DM1010 is tuned to a suitable signal, the Signal Level light 
will turn Green as will the Sync, EQ and TOV lights. You may see the Gain and Attenuators on the left side 
change as the AGC sets the proper gain level. 

 

Transport and Analysis Modes 

WinDM ProÔ  operates in two distinctive modes, Transport Stream mode and Analysis Mode. When 
operating in Transport Stream Mode, all three transport stream output signal formats are available. When 
operating in Analysis Mode, the transport stream output signals are turned off. The lower left portion of the 
status bar indicates the operating mode as well as the upper right Status screen indicates the condition of 
the Transport Stream. The Tools ®  Options ®  Demodulator Menu provides the selection between 
Analysis and Transport Stream Modes. 
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Figure 4: Tuned to channel 37, Viewing Time Plot, Transpor t Stream Mode is On 

  

Figure 5: Viewing Taps Tab, Transpor t Stream Mode is On, (Echo Profile) is inactive.
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WinDM ProÔÔÔÔ  Organization 

WinDM ProÔ  displays consist of several major components, each of which are described on the following 
pages. All areas of control and display are described in detail. See the above WinDM ProÔ  start screen to 
find the area being discussed as it relates to the full PC screen presentation. 

Status Indicators 

Positioned to the right of most screen Plots is the Status Indicator Panel.  The details reported within this 
area will be reviewed. 

     

This panel shows Data Recording Off, 
Transport Stream On and 
Communications is being Received 
from the PC. 

     

This panel has the Data Recording Off 
and Transport Stream Off.  

The Status Panels above contain these indicator displays from top to bottom. A 
short description in included. 

RF Input Power a value in dBm is reported. This power reading is accurate and 
traceable to NIST.  The reported number can be offset by navigating through the 
DM1010 Front Panel Menus to the area that allows an operator to add or subtract a 
specific user-defined value from the RF Input Power reading. 

Signal Level either correct (OK, green) or too high (amber up arrow) or too low 
(amber down arrow). Under steady state conditions, it is critical for this indicator to 
be correct (OK, green.)  Note: At times, this indicator may register amber. It should 
settle to correct (OK, green) after a few seconds have past. When the Signal Level 
indication is green, it indicates internal instrument gain and attenuator settings are 
working properly and a valid RF Input Power number is being reported. 

Sync Locked (green) or Unlocked (red). A Lock here indicates a valid 8VSB signal 
is being received and that the internal decoder has locked to Field Sync. 

EQ Equalizer either Locked (green) or Unlocked (red). A Lock here indicates the 
next step of correct decoding has occurred and Equalizer Lock has been achieved. 

TOV Threshold Of Visibility Locked. When TOV is green(locked) it indicates that 
three events have successfully occurred. 1) Sync Lock has been achieved 2) EQ 



 Section 3: WinDM Pro 
  

DM1010 User Manual Page 3-9 

Lock has been achieved and 3) The SNR (hardware SNR) is equal to or above 
15dB. 

Data Recording either On (green) or Off. Turning Data Recording On/Off is 
accomplished through the Tool Bar and Menu Bar controls. 

Transport Stream either On (green) or Off. Turning Transport Stream On/Off is 
selected by navigating to Tools ®  Option ®  Demodulator area of the Tools Menu.  
If Transport Stream indicator is On (green) the Instrument is in Transport Stream 
Mode and Instrument Transport Stream outputs are active.  If Transport Stream 
indicator is Off (red), the instrument is in Analysis Mode, the Transport Stream 
outputs are inactive, and the Taps Tab displays valid Tap data. 

Communications either Receive/Transmit/None. This is provided as a 
“confidence” tool so the user can monitor the status of communications between 
Win Dm Pro and the DM1010.    

 

Active Cursor Panel 

  

The right side of WinDM ProÔ  contains the Active Cursor Panel. When an active cursor is enabled by the 
check box as indicated above, a vertical green line appears on graph areas. Pressing the left mouse 
button while the cursor is over a plot, the cursor moves to that horizontal position on the plot and begins 
reporting data. Use the mouse button, to drag the cursor to a new screen location, or  simply click at any 
new location on the plot. The left and right arrows on the Active Cursor Panel can also be used to move 
the cursor to left or right on the plot being viewed. The active cursor is available for Time Plots, Taps Plots 
and Spectrum Plots. 
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Figures of Merit Panel 

        

Below the Active Cursor Panel, Figures of Merit are displayed. This panel reports values as calculated by 
the DM1010/ WinDM ProÔ demodulator system. The information displayed is a function of the selected 
plot. Most information displayed as Figures of Merit can be graphed in the Time Plot tab. 

Some Figures of Merit parameters have multiple display areas for different types of collected data. For 
example, the DM1010 has the ability to determine and report parameter values at three different points in 
the decoding process: 1) Before Equalization 2) After Software Equalization (sometimes thought of as 
Static Equalization) and 3) After Hardware Equalization (sometimes thought of as dynamic Equalization.) 
The list below shows parameters that can be reported from more than one decoding process. 

SNR 

Parameter: Signal to Noise Ratio 

Available Before Equalization, Software Equalized, and Hardware Equalized. 

EVM 

Parameter: Error Vector Magnitude 

Available Before Equalization, Software Equalized, and Hardware Equalized. 

MER 

Parameter: Modulation Error Ratio 
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This parameter is sometimes referred to as “complex SNR.” It is a measurement of the error in the 
received I and Q values from their ideal values. MER is available Before Equalization and Software 
Equalized. 

SER 

Parameter: Segment Error Rate 

This is a number relating to segment errors within a received 8VSB signal. It has a range of 0 to 65535 
with 0 being the best. SER is available Hardware Equalized. 

Tap Energy 

Parameter: The ratios in dB of the entire (sum of all) Minor Tap values relative to the Main Tap. 

MSE 

Parameter: Mean Squared Error of the decoded 8VSB signal produced by the decoder device.  

For this parameter, smaller is better. 

AGC 

Readout of the Automatic Gain Control voltage.  The AGC voltage is an analog voltage that controls the 
gain of the instrument as it switches between RF & IF amplifiers and internal 10 dB fixed steps of 
attenuation. This voltage may fluctuate between 2.5 and 3.7 Volts. 

 

Title Bar 

 

The Title Bar, at the top of WinDM ProÔ  displays from left to right, Z Technology, WinDM ProÔ  (8-VSB 
Measurement Receiver) the Data Recording File name and location if a Data Recording File is open. The 
portion shown as (8-VSB Measurement Receiver) is the type of product connected to WinDM ProÔ . A 
data file is initially created and is ready to record data. 

Menu Bar 

 

The Menu Bar consists of three menus, File, Tools and Help. 
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File Menu 

 

The File Menu provides the ability to create a New data recording file, Open an existing Data Recording 
file or Close an opened Data Recording file. 

If a Data Recording file is open, the name of the file and its path is shown in the top blue banner Title bar. 
As shown above, the default Data Recording file is named manual1.dat and is located in  
\Documents and Settings\All Users\Shared Documents\Z Technology folder. 

Tools Menu 

 

The Tools Menu can be used to Hold Updates which stops and restarts communications with WinDM 
ProÔ , start recording data to the open Record Data file, resize displayed graphs using Hide Left 
Panel, Configure and Launch TSReader Pro (when Option:TSR is present), capture the screen image 
and it to a file, set up the screen capture process and file types, set parameters for the Data Recording 
file and Event Log file and Edit Instrument Data. Each of these menus is described below.  

The Record Data file is used to log parameters collected by the DM1010. Each record in the Recorded 
Data file is time & date stamped. The Data Record file is a comma-separated file suitable to import into 
a spreadsheet program for data manipulation.  

The Event Log stores information about the operation of WinDM ProÔ . The information consists of 
date & time WinDM ProÔ  is started and exited and any problems encountered by the program. 
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The size limit for the Data Recording file and Event Log file can be set. When the size limit is exceeded, a 
warning pop-up window appears. 

A sample Data Recording file is shown at the end of section 3. 

Tools Menu: Hold Updates/Start Updates 

Selecting Hold Updates/Start Updates toggles between stopping and restarting communications between 
WinDM ProÔ  and the instrument. Using this menu selection, graphs and other displays can be frozen at 
one specific state. This feature is provided to allow careful analysis of static plots and to allow a screen 
capture to be made of a display that is not changing with each transfer of data between DM1010 and the 
PC. 

       

Tools Menu: Hide Left Panel/Show Left Panel 

The Hide Left Panel/Show Left Panel menu provides a method to increase the size of any graph being 
displayed by WinDM ProÔ . This menu selection can be activated for any of the Plot tabs including 
Time Plot, Taps, Spectrum, Constellation, and Eye Pattern. 
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Example of a Time Plot with the Left Panel hidden  

 

 

    

Example of a Time Plot with the Left Panel visible 
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Tools Menu: Configure TSReader Pro 

When the Option: TSR is part of the DM1010 package being used, I.E. TSReader Pro is installed on the 
PC, the Configure TSReader Pro and Launch TSReader Pro selections appear in the Tools Menu.   
Documentation provided with this option gives a full set of instructions on how to configure the features 
provided with the option.  

The TSReader Pro Configuration window shown below lists the Application Path and the User Arguments 
normal for operation of this option. Both sets of information can be changed from this window.  

The Launch TSReader Pro menu selection activates the program, which can run simultaneously with 
WinDM ProÔ . 
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Tools Menu: Screen Capture 

 

This dialog provides the options to define how the Capture button will produce a graphic file. A sample file 
name is shown for Output Filename Format: as Image Type: and File Name are selected. Output can be 
sent to a file or a printer. Input can come from the complete PC screen, a window within WinDM ProÔ  or a 
user defined region. For a user defined region, the operator drags a box around the area to be captured.  

Certain Default settings must be entered into the screen capture program provided with WinDM ProÔ  and 
used to implement the Capture Options feature discussed. At this writing, the application being used is 
Snag-iTÒ by TechSmithÒ.  For more details see Section 4 of this manual. 

Tools Menu: Data File Info … 

 

This dialog box is used to set file size limits beyond which a warning indication is generated by the 
computer running WinDM ProÔ . When the Size Limit entered in the box is exceeded a warning window 
will appear on the PC screen.  This feature is provided prevent data files from inadvertently building 
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beyond the range normally expected.  The menu selections here allow for View File and Archive a file.  
When View File is selected a Notepad display similar to the one below will appear. 

 

When the Archive button is selected the contents of the data file is archived to the location indicated with a 
new file name based on the current date and time.  The data in the existing file is cleared (except for the 
proper headers) and ready to start a fresh recording. 

Tools Menu: Event File Info … 

 

This dialog box is used to set file size limits beyond which a warning indication is generated by the 
computer running WinDM ProÔ .  When the Size Limit entered in the box is exceeded a warning window 
will appear on your PC screen.  This feature is provided to prevent event files from inadvertently building 
beyond the range normally expected.  Menu selections here allow for View File and Archive a file.  When 
View File is selected a Notepad display similar to the one below will appear. 
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When the Archive button is selected the contents of the event file is archived to the location indicated in 
the text area of the Event Log Size dialog box with a new filename based on the current time and date. A 
current event file contents is cleared and ready for use. 

 

Tools Menu: Edit Instrument Data 

 

This dialog is used to change the Name, Group and Location information stored in the DM1010 and 
displayed above the various plots of WinDM ProÔ . The same information is displayed on the Status 
Menu of the DM1010 front panel set of menus. See section 2 of this manual. When the Edit Instrument 
Data Name and/or Location box are blank, the instrument serial number will be substituted and visible 
in the appropriate WinDM ProÔ  displayed area.  

 

Tools Menu: Options – Demodulator 

The next item in the Tools Menu is the Options menu. The Options menu consists of three tabs. The 
first tab is Demodulator. This tab is where the Demodulator is changed between Analysis Mode and 
Transport Stream mode. Information is listed to the right of the Mode button. Addition details 
concerning selecting Transport Stream mode have been discussed in an earlier section.  
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This menu also provides for selecting between Channel 7 or Channel 8 DTV outputs. There are two 
Channel 7/8 coaxial outputs on the DM1010 rear panel. These outputs can be set to either Channel 7 
or Channel 8. The selected channel will have the received DTV signal (from the RF Input connector on 
the rear panel) down converted and available for use on the two CH7/8 rear panel connectors. The 
VHF channel output signal is for use in a test laboratory or for redistribution of a received UHF channel 
that has been mixed down to an easy to distribute VHF signal. 

 

Tools Menu: Options – Security 

The Security tab provides the ability to lock or unlock WinDM ProÔ . With the input locked WinDM 
ProÔ   will not respond to inputs that control hardware settings. This can be used to secure accidental 
changes to the demodulator like changes to the channel. 
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Tools Menu: Options - Recording 

The Recording tab of the Options menu provides the means to set the time interval of the Data 
Recording. If the entry in the Hour(s) field is set to 1 and Minute(s) and Second(s) are set to 0, a new 
record will be created once each hour. Information is listed to the right of the tab. 

  

Tools Menu: Connect 

The last item in the Tools Menu is Connect. Selecting this item will bring up the Connect dialog box. 
The Connection process was discussed earlier in this section of the manual.  The Connect dialog box 
allows the user to re-initialize communication to a DM1010. 
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Help Menu 

The Help menu provides information about the hardware and software.   

  

If Z Technology Home Page is selected, the operator is connected to the Z Technology home page via 
an Internet connection. The link is www.ztechnology.com.  

If About Z Technology WinDM ProÔ   is selected, the following appears. 

 

Configuration information about your specific DM1010 Demodulator is listed in the scroll box. 
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Tool Bar 

 

 

The Tool Bar provides quick access to several items in the Menu Bar.  By resting the cursor over an icon, 
a Tool Tip will appear with a short description or name for the button. Here is an example:  

 

A more detailed explanation of the name and use for each button is provided in the table below. 

Tool Bar 

        

Name Create 
New 
Data File 
button 

Open 
Data File 
button 

Start Data 
Recording  
button 

Hold 
Updates 
button 

Capture 
button 

Hide Left 
Panel 

View 
Alarm 

Launch 
TSReader 
Pro 

Description Create a 
new Data 
Record 
File 

Open an 
existing 
Data 
Record 
File  

Begins 
Data 
Recording 

Freeze 
graph 
screen 

Capture 
Screen 

Expands 
Plots by 
Hiding 
Input & 
Graph 
Panels  

Displays 
the 
Alarm 
Monitor 

Calls up or 
Closes 
TSReader 
Pro 
Application 
(when 
installed) 

Short Cut F1 F2 F4 F3 F8 F5  F7 

Notes: Also 
accessed 
from the 
File 
Menu 

Also 
accessed 
from the 
File Menu 

Also 
accessed 
from the 
Tools 
Menu  

Stops 
/Starts 
updating 
of graph. 

This 
button is 
only 
available 
if 
SnagItÔ  
is 
installed. 

Hides 
/Shows 
Control 
Panel to 
Left of 
Graphs 

Provide 
access to 
set the 
alarm 
limits. 

Toggles 
between 
Launch and 
Close of 
TSReader 
Pro 
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Alarms Monitor 

When the View Alarms icon  is selected, the following window appears. Several active signal 
parameters are displayed across the screen. Each can be selected using a check box next to each name. 
Each checked parameter’s Current Value is reported and automatically monitored. Both Critical and 
Caution levels relating to each parameter can be individually set and that level becomes an alarm trigger 
point. When an critical or caution alarm boundary is crossed, the Alarm State line is flagged with a Yellow 
(Caution) or Red (Critical) colors and the Alarms File receives and stores the data in comma delimited 
format for future review. 

Note: As of this writing RF Power is implemented in the Alarms Monitor area. Additional capability will be 
added over time. 
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Graphing Feature and Plot Tabs: 

There are five separate Tabs available along the bottom central part of the screen. They give the user 
access to many useful and important measurement parameters.  This section discusses each of these 
displays, available control panels and discusses general methods of effective operation and usage for 
each Plot Tab. 

First we will describe some common Input and Control Panels used for several of the plots. 

Available Tabs: Time Plots  ®®®®   Eye Patterns 

Along the lower central portion of the screen is a series of Tabs. They include: 

 Time Plot 

 Taps (Decoder Echo Profile) 

 Spectrum Plot 

 Constellation Plot 
 Eye Pattern Plot 

 

 

Each Tab opens a different set of plots or graph windows with accompanying signal parameters. There are 
several control and reporting panels common to many of the tabs.  We will discuss these as we describe 
the various plots and graphs. 
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Time Plot 

Select the Time Plot Tab for access to multiple parameters plotted versus time. 

Input Panel: Time Plot & Taps 

The input Panel shown here is common for both Time Plots and the Taps area. 

         

Figure 5: RF Section in 
Manual Gain mode 

          

Figure 6: RF Section in 
AGC mode 

Above is the RF Module tuned to 
Channel 46, in Manual gain with the RF 
Amplifier On and attenuation se to 0dB. 

Above is the RF Module tuned to 
Channel 40 in AGC. 

The Input Panel provides selection of IF (44 MHz) Input or RF Channel selection. Channels can be 
selected by placing the cursor in the channel window and entering a channel number, by selecting the 
drop-down box and selecting a channel, or by using the Up and Down arrows. The center frequency for 
each channel is listed below the channel number. 

The Gain section provides a display of the Attenuation and RF Amplifier status when in AGC mode. If the 
mode is changed to Manual, the user has control of the Attenuation and the RF and IF Amplifiers. If the 
user selects Manual Gain control, care should be taken to prevent signal overload caused by improper 



 Section 3: WinDM Pro 
  

DM1010 User Manual Page 3-27 

gain/attenuator settings.  To monitor this for correct levels, watch the Status Indicator Panel and Signal 
Level (OK, green) button. A discussion of this issue was covered earlier in this section of the Manual. 

Time Graph Properties 

The Graph Control Panel is accessible from several Plot Tabs including the Time Plot Tab. The panel can 
have several variations depending on usage and setup procedures. 

The following 15 parameters can be plotted when the Time Plot tab is 
selected. Each parameter is selected from the Plot vs. Time… drop-
down list. Not all parameters are available all the time. These 
parameters are in listed order from top to bottom. 

Parameter Available Conditions 

RF Power 

Sync lock 

EQ lock 

TOV 

Tap Energy 

SNRhw 

EVMhw 

SER 

AGC 

SNRbe 

EVMbe 

MERbe 

SNRsw 

EVMsw 

MERsw 

All the time 

All the time 

All the time 

All the time 

From Taps Tab 

From Constellation Tab 

From Constellation Tab 

All the time 

All the time 

From Constellation Tab 

From Constellation Tab 

From Constellation Tab 

From Constellation Tab 

From Constellation Tab 

From Constellation Tab 

 

 

 

 

 

 

 

 

 

Equalize Off 

Equalize Off 

Equalize Off 

Equalize On 

Equalize On 

Equalize On  

Note: From Taps Tab means select the Taps Tab first then the Time 
Plot tab. From Constellation Tab means select the Constellation Tab 
first then the Time Plot Tab. Equalize On/Off is available from the 
Constellation Tab. 
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WinDM ProÔ  allows many parameters to be plotted versus time. Parameters available for plotting 
depend on the graph viewed just before clicking the Time Plot Tab. In the first screen capture 
below, the Taps tab was the graph viewed before the Time Plot tab was selected.  For the second 
screen capture below, the Spectrum Tab was the one selected before moving to the Time Plot tab. 
Each set of time plots has its unique list of parameters available for plotting. (See above) The list 
expands or contracts depending whether Decoder, Spectrum, Constellation or Eye Pattern 
information is being plotted. The list also may change depending on parameters activated or 
deactivated for each type of plot. For example, the third screen capture below can include a third 
set of SNR, EVM & MER parameters when these are activated in the Constellation Plot area.  

Taps or Decoder Time Plots

 

 

Spectrum  Time  
Plots 

 

Constellation Time 
Plots 

 

Eye Pattern Time 
Plots 
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 Time Plot Graph: SNR Before Equalization 

Here is an example of a Time Plot of the parameter SNRbe showing the results of the type of graph 
available after proper settings are made to the Input and Graph Panels. 
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Taps Plots or Echo Profile Plots 

Select the Taps Tab to access Echo Profiles and Taps Time plots. 

Taps Graph Properties 

When the Taps Tab is selected, many features from the hardware 8VSB Decoder are accessible. The 
Graph Panel for the Taps Plot area has several unique controls.  They are discussed below. 

The Taps Graph Properties provide the user with various 
parameters to change how the graph is displayed. Tool Tips are 
available by holding the cursor over each item. 

The Window slider adjusts the horizontal position of the Taps 
display. 
The Tap Size slider adjusts the horizontal gain of the displayed 
graph. 
The Y Mag. Slider adjusts the vertical gain of the displayed graph. 

The Reset button resets the three sliders above this button to their 
default condition. 

Sweep Width provides the selection of these four sweep widths. 

The NTSC Co-channel button enables the decoder to operate 
better in environments where an NTSC channel is received on the 
same channel as a DTV signal. 
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Sample Taps Graph 

Below is a detail of an Echo Profile from a received 8VSB signal on Channel 37. It is viewed by selecting 
the Taps Tab.  

Note: Taps Plots may be de-activated from the Tools Menu. This will automatically occur when Transport 
Stream Mode is activated. When this is done, Echo Profile Plots are not accessible and Taps plot screen 
turns gray indicating this status. See Figures 4 & 5 in an earlier section. Also review discussions about the 
Tools Menu relating to this path:  Tools ®  Options ®  Demodulator. 
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Spectrum Plots 

Select the Spectrum Plot Tab to access signal power versus frequency plots. 

Input Panel: Measure button 

The Input Panel shown below is common for the Spectrum Plot, Constellation Plot and Eye Pattern Plot 
tabs.   

 

The Input Panel for the Spectrum, Constellation and Eye Pattern 
tabs has a Measure button. The Measure button is used to 
optimize internal gain and attenuator settings during viewing of 
Spectrum Display Plots versus the reference FCC Mask. The 
Measure button optimizes signal levels throughout the DM1010 to 
the best possible setting for viewing signal roll-off near the –47dB 
shoulder areas. After selecting the Measure button, the instrument 
noise floor will normally be approximately 10 dB below the –47dB 
shoulders. 

Selecting this button puts the DM1010 in a temporary mode that 
disables the AGC and adjusts the gain to optimize performance for 
this measurement. 

With the Measure button selected, measurements can be 
accurately made for Spectrum, Constellation and Eye Pattern Plots. 

When finished with these measurements, the use should unselect 
the Measure button for normal AGC operation.  

 The Question Icon to the left of the Measure Button can be clicked 
with the mouse. Doing this brings up a short description of the 
operation of the Measure Button. 
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Spectrum Graph Properties 

The Graph Panel for the Spectrum Plot tab is described in detail. 

The Spectrum Graph Properties provide the user with various 
parameters to change how a graph is displayed. Tool Tips are 
available by holding the cursor over each item. 

The Averaging buttons provide averaging of 4, 8, 16, 32 
successive sets of data or no averaging when the 1 button is 
selected. 

The two Span buttons provide a 10MHz span for observing a 
single DTV signal. The 18MHz span provides the ability to view  
upper and lower adjacent TV channel signals when these are 
present.  

Overlays provide a DTV Transmission FCC Mask and a Pilot 
cursor. The vertical line indicates the Pilot frequency. 

 

Options provide a Video Filter to average out noise.  

The Adjacent NTSC button allows the DM1010 to find the Pilot 
carrier when a lower adjacent NTSC signal is present. Use this 
button as needed.  

When the ATSC button is selected, Total DTV Power becomes 
the reference used to establish 0dB on the vertical axis. Plots of 
the received spectrum are then correctly referenced to Total DTV 
Power. When ATSC is unselected, the highest received signal on 
the Spectrum Plot will be set at the 0dB reference point. (There is 
approximately 10.62dB difference in vertical position between the 
two settings.)  

The Clear button is provided for the user to remove all existing 
plots and restart the graphing process anew. 
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Sample Spectrum Graph 

Below is an example of a Spectrum Plot for a DTV signal on Channel 37. The Mask button is selected; 
therefore the FCC Mask is visible as an overlay on the screen.  The 10MHz Span button is also selected. 
Note: Channel 37 has been selected as the received channel via the Input Panel. In this screen capture, 
the Input Panel is now hidden beneath the Graph Panel. 
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Sample Spectrum Graph  

This Spectrum Plot is of the same DTV signal on Channel 37. In this case, the 18MHz Span button has 
been selected.   
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Sample Spectrum Graph  

The next Spectrum Plot example presented is of the same DTV signal on Channel 37. However, in this 
case, the Measure Button (on the Input Panel hidden, but to the left of the screen) was selected. 
Selecting the Measure Button optimizes internal gain settings and proves active read-outs of signal power 
levels in the –47dB shoulder areas of the FCC Mask.  In addition to the calculated signal power number 
displayed next to each shoulder area, a short horizontal line indicates this level on the graph.  When 
making the measurement, it is important to average several Spectrum Captures (in this case we are 
averaging 32 captures). During this measurement, it is critical for both ATSC button to be selected and 
Video Filter button to be unselected.  The ATSC button was discussed earlier under the Spectrum Graph 
Properties area of this manual. As with any spectrum plot, video filtering can disrupt measurement 
accuracy at band edges and nullify accuracy of filter measurements. Finally, the user will notice the noise 
floor of the instrument is approximately –55dB down on the graph. This is the approximate noise floor of 
the DM1010 when it is operating correctly. This noise floor level allows for valid shoulder measurements at 
the –47dB level. 
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Sample Spectrum Graph  

The following DTV Channel 37 signal as shown above but with the 18MHz Span button selected.  

 

 

 

Constellation Plots 

Select the Constellation Tab to access the I/Q 8-Level Constellation plots and associated parameters. 
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Constellation Graph Properties 

The Input Panel for the Constellation Plot tab is similar to the Spectrum Plot and is described above. The 
Constellation Plot Graph Panel is discussed in this section. 

The Constellation Graph Properties provide the user with various 
parameters to change how the graph is displayed. Tool Tips are 
available by holding the cursor over each item. 

The Captures buttons provide for the number of Constellation 
captures displayed simultaneous on the graph. Example: If the 2 
button is selected, the last two captures are displayed. 

The Clear Plot button allows the operator to clear all existing 
graphical information on a plot and restart the capture process. 

The Overlays section provides Ideal I Values and Decision 
Boxes Buttons. The Ideal I Values are eight vertical dotted lines 
indicating where the ideal Constellation dots should land. The 
Decision Boxes button places solid vertical lines mid point 
between the Ideal Values.  

The Options section provides the ability to display only the field 
sync when the Field Sync button is selected. 
The Equalize button displays the Constellation with software-
calculated equalization when selected or non-equalized when not 
selected. When the Equalize button is selected for the first time for 
any given channel, a calculation of equalization values will 
automatically be performed. This calculation consists of capturing 
equalization data from 4 sequential field sync levels of the 
received signal. This data is analyzed and the best-fit static 
equalization values are determined. These values are then applied 
continuously to the incoming 8VSB signal (on the selected 
channel) during Constellation and Eye Pattern decoding and 
display processes.  

The Equalization button will perform a recalculation of the best-fit 
static equalization values when selected. The Equalization button 
is on the bottom of the Graph Panel shown to the left. 

       

To the left is a sample of the DM1010 calculating equalization 
values. This graph will be painted four times as the software 
equalization process is executed. See the discussion above for 
more details. 
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Sample Constellation Graph 

A Constellation Plot is shown below. This example has the Equalize button selected and the Software 
Equalization process completed. Therefore, all three SNR,EVM,MER sets of values are active and 
reporting data. If the Equalize Button is not selected, the middle set of SNR,EVM,MER numbers will be 
blank. 
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Sample Constellation Graph: Field Sync 

A Constellation Plot with the Field Sync and Equalize buttons selected. 
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Eye Pattern Plots 

Select the Eye Pattern Tab to access the 8-level plots and parameters found in this area of the 
Application. 

Eye Pattern Graph Properties 

The Eye Pattern Plot has still another unique Graph Panel that is revealed when the Tab is selected. This 
section describes its control features. 

The Eye Patterns Graph Properties provide the user with various 
parameters to change how the graph is displayed. Tool Tips are 
available by holding the cursor over each item. 

The Interpolation section provides for Linear, SinX/X or no 
interpolation depending upon which button is selected.. 

 

The Overlays section provides 8 dotted horizontal lines in the 
center of where the dots should land under ideal conditions when 
the Ideal I Values button is selected. The  Decision Boxes button 
displays solid horizontal lines mid point between the ideal values. 

The Options section provides an Eye Pattern graph of the field 
sync. 
The Equalize button operates the same as it does for the 
Constellation description on the previous page. 

The Compress Scale button decreases the vertical scale to be 
able to see more of the transitions. 

 

The Equalization button operates the same as it does for the 
Constellation description on the previous page. 
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Sample Eye Pattern Graph 

Eye Pattern Plot with SinX/X button selected. 

 



 Section 3: WinDM Pro 
  

DM1010 User Manual Page 3-43 

 Sample Eye Pattern Graph  

Eye Pattern Plot with SinX/X and Compress Scale Buttons selected. 
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Sample Eye Pattern Graph: Field Sync 

Eye Pattern Plot with Linear, Compress Scale and Field Sync buttons all selected. 
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Sample Eye Pattern Graph: Field Sync 

Eye Pattern Plot with Field Sync, SinX/X and Equalize buttons selected. 
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Sample Eye Pattern Graph: No Interpolation 

Eye Pattern Plot with Linear and SinX/X both unselected. 

 

 

 

Data Logging 

As mentioned earlier in this manual, Data Log files can be created for storage of parameter data that 
has been measured and monitored by the DM1010. Each data file has a specific format. 

The Data Log files are used to log collected signal parameters. Each record in a Data file is time & 
date stamped. The Data file is a comma-separated file suitable to import into a spreadsheet program 
for data manipulation. 

A sample Data Log file 

The following is a sample Data Log file containing four records. 
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© DM1010$DataFileVersion=2.0 

© Instrument:DM1010 

© Options:Ethernet,CF 

© Date, Time, Channel, ©Ch©, RFPower, Power Units (dBm),AGC On (1=On|0=Off), RF Amp On 
(1=On|0=Off), Attenuation [dB], IFAGCVoltage[V],GainState (+1=Too high|0=OK|-1=Too low), 
SyncLock (1=Locked|0=Unlocked), EQLock (1=Locked|0=Unlocked),TOV (1=SNR>14.9 
dB|0=SNR<=14.9 dB),SNR Before Equalization[dB], EVM Before Equalization[%], MER Before 
Equalization [dB],Software Equalized SNR [dB], Software Equalized  EVM [%], Software Equalized  
MER [dB],Hardware Equalized SNR [dB], Hardware Equalized  EVM [%],MSE, SER, 
TapsDataAvailable (1=Taps data follows|0=No data follows),TapEnergy [dB], MinimumTapTime 
[usec], MaximumTapTime [usec], NumTaps, ...TapValues.. 

10/25/2005 ,11:11:45 AM ,46,Ch,-46.7,dBm,1,1,10,3.3,0,1,1,1,,,,,,,23.1,6.5,34,0,1,-19.1,-
2.322938,10.406760,138,0,-1,-1,-1,-1,-1,-1,0,-1,-1,-1,-1,-1,-1,-1,-1,0,-1,0,-1,-1,-1,0,0,1,87,-2,-1,-1,-
1,-1,0,-2,-2,-1,-1,-1,-1,0,0,0,-1,0,-1,-2,0,0,1,-1,0,-1,0,-1,0,-1,0,0,0,-1,-1,-1,-1,-1,-1,-1,0,-1,0,0,-1,0,-
1,0,0,-1,-1,0,0,0,0,0,0,-1,0,0,-1,-1,0,0,-1,-1,0,0,0,0,-1,-1,-1,0,-1,-1,-1,0,-1,-1,0,-1,-1,-1,2,-1,0,0,0,-1,-
1,0,0,0,0,-1,0,-1,0,0,-1,-1,0,0,0,0,0,-1,0,0,0,-1,-1 

10/25/2005 ,11:11:49 AM ,46,Ch,-46.9,dBm,1,1,10,3.3,0,1,1,1,,,,,,,22.8,7.3,38,0,1,-19.2,-
2.322938,10.406760,138,-1,-1,0,0,-1,-1,-1,0,-1,0,-1,-1,-1,-1,0,0,0,-1,0,0,-1,-1,0,0,0,87,-1,-1,-1,-1,-
1,-1,-1,-1,0,-2,-1,-1,2,0,-1,-1,0,0,-2,0,0,1,0,0,-1,0,-1,0,-1,0,0,-1,-1,-1,0,-1,-1,-1,-1,-1,-1,0,0,-1,0,-1,0,-
1,-1,-1,0,0,-1,0,-1,0,-1,0,0,-1,0,0,-1,-1,-1,0,-1,-1,0,-1,-1,-1,0,-1,-1,-1,0,-1,-1,-1,0,0,-1,2,-1,1,-1,0,-1,-
1,0,0,0,0,-1,0,-1,0,0,-1,-1,0,0,0,0,0,-1,0,0,-1,-1,0 

10/25/2005 ,11:12:53 AM ,46,Ch,-46.9,dBm,1,1,10,3.3,0,1,1,1,,,,20.7,8.2,20.7,22.9,7.3,25,0,1,-
18.9,-2.322938,10.406760,138,-1,0,-1,-1,-1,-1,-1,0,-1,0,-1,-1,-1,-1,-1,-1,0,-1,0,0,-1,-1,0,-1,0,87,-
1,0,0,-1,-1,1,-1,0,0,0,-1,-1,1,0,-1,-1,0,-1,-2,-1,1,1,-1,0,-1,0,-1,-1,-1,0,0,0,-1,-1,-1,0,-1,-1,-1,-1,0,0,0,-
1,-1,0,0,-1,-1,0,-1,0,-1,0,-1,0,-1,0,0,-1,0,0,-1,0,-1,0,0,0,-1,-1,-1,0,0,0,0,0,0,-1,-1,-1,0,-1,-1,2,-
1,0,0,0,-1,-1,0,0,0,0,0,0,-1,0,0,-1,0,0,0,0,0,0,-1,0,0,0,-1,0 

10/25/2005 ,11:12:56 AM ,46,Ch,-46.9,dBm,1,1,10,3.3,0,1,1,1,,,,19.6,9.6,19.6,22.3,7.3,51,0,1,-
18.9,-2.322938,10.406760,138,-1,0,-1,-1,-1,-1,-1,0,-1,0,-1,-1,-1,-1,-1,-1,0,-1,0,0,-1,-1,0,-1,0,87,-
1,0,0,-1,-1,1,-1,0,0,0,-1,-1,1,0,-1,-1,0,-1,-2,-1,1,1,-1,0,-1,0,-1,-1,-1,0,0,0,-1,-1,-1,0,-1,-1,-1,-1,0,0,0,-
1,-1,0,0,-1,-1,0,-1,0,-1,0,-1,0,-1,0,0,-1,0,0,-1,0,-1,0,0,0,-1,-1,-1,0,0,0,0,0,0,-1,-1,-1,0,-1,-1,2,-
1,0,0,0,-1,-1,0,0,0,0,0,0,-1,0,0,-1,0,0,0,0,0,0,-1,0,0,0,-1,0 
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The field names from left to right are: 

© Date, Time, Channel, ©Ch©, RFPower, Power Units (dBm),AGC On (1=On|0=Off), RF Amp On 
(1=On|0=Off), Attenuation [dB], IFAGCVoltage[V],GainState (+1=Too high|0=OK|-1=Too low), SyncLock 
(1=Locked|0=Unlocked), EQLock (1=Locked|0=Unlocked),TOV (1=SNR>14.9 dB|0=SNR<=14.9 dB),SNR 
Before Equalization[dB], EVM Before Equalization[%], MER Before Equalization [dB],Software Equalized 
SNR [dB], Software Equalized  EVM [%], Software Equalized  MER [dB],Hardware Equalized SNR [dB], 
Hardware Equalized  EVM [%],MSE, SER, TapsDataAvailable (1=Taps data follows|0=No data 
follows),TapEnergy [dB], MinimumTapTime [usec], MaximumTapTime [usec], NumTaps, ...TapValues.. 

Summary 

The DM1010 provides a tool for the robust reception, measurement, and logging of ATSC compliant 8VSB 
broadcast signals. This demodulator provides a full time output for the television station house monitoring 
system and extensive measurement capabilities for the station engineer. Signal parameters may be 
recorded to open-format comma-delimited files while MPEG transport streams are being faithfully output 
for analysis using industry standard test instrumentation. 
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Section 4: System Setup & Operation 
Introduction 

The WinDM Pro™ requires a WindowsÒ based PC to operate. Operation of the DM1010 is through the serial 
port of the PC using the supplied 3-meter cable. 

Install the software 

Software supplied to operate the DM1010 is called WinDM ProÔ . A companion software package 
used for screen capture is called Snag-It and is also supplied. The software is installed on the users 
PC. All software is supplied on a CD. WinDM ProÔ  will be installed first. 

Note: If you are reinstalling WinDM ProÔ on a PC that already has WinDM ProÔ installed, remove the existing 
installation first using the Windows ADD/ Remove Programs tool from Control Panel. 

Install WinDM ProÔÔÔÔ  

A. Insert the WinDM ProÔ  CD in your CD ROM drive. If the installation does not start automatically, press 
the WindowsÒ Start button, select Run, in the dialog box enter “D:\setup”  without the quotes then press 
Enter. If D is not your CD ROM drive, substitute the correct drive letter. 

B. Complete the WinDM ProÔ  installation by following the prompts. 
Click on the Finish button when the installation completes. 
To launch WinDM ProÔ , goto Start ®  All Programs ®  Z Technology ®  WinDM Pro 

Install SnagItÔÔÔÔ  

A. Insert the Snag-ItÔ  CD in your CD ROM drive. If the installation does not start automatically, press the 
WindowsÒ Start button, select Run, in the dialog box enter “D:\setup”  without the quotes then press Enter. 
If D is not your CD ROM drive, substitute the correct drive letter. 

Complete the Snag-It installation by following the prompts. 
Click on the Finish button when the installation completes. 
Once SnagIt is installed Start SnagIt to do some post installation configuration to allow WinDMpro to use SnagIt 
for automated screen captures. 

A. Click on the Windows START button then click on ALL PROGRAMS, then click on the SNAG-IT 7 
folder, then click on SNAG-IT 7.  The Snag-It screen capture program will appear. 

B. On the VIEW menu click on CLASSIC. To the question SWITCH TO CLASSIC VIEW click YES. 
C. On the TOOLS menu select PROGRAM PREFERENCES.  On the Program Options Tab, Uncheck 

RUN SNAG-IT WHEN WINDOWS STARTS. 
D. Close SnagIt. 

 
 
SnagItÔ  is used from the Tool Bar of WinDM ProÔ using the capture button . 

Connect the equipment 

A. Locate the DM1010 where it will be used. 
Connect the supplied power cord between the DM1010 rear panel power connection and the AC mains. 
Connect the supplied serial port cable between the DM1010 rear panel connector labeled Serial Port and the 
PC’s serial connector. The D-Sub 9 serial cable is female on the computer end and male at he DM1010 end. 
Turn on the DM1010. The power switch is located on the rear of the product. 
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Starting WinDM ProÔÔÔÔ 

B. Before starting the DM1010 application software, WinDM ProÔ, turn on the power to the DM1010. 
C. Launch the WinDM ProÔ  application on the PC. Using the default installation of WinDM ProÔ, the 

location is Program Files ®  Z Technology ®  WinDM Pro. 

Location of System Components 

The DM1010 front panel contains a power on indicator located on the right side of the product. The 
center of the front panel is an LCD display with a Z Technology logo. The buttons and Tune knob do 
nothing and are for future development. 

The rear panel contains all of the RF Input and Output connectors, power switch with fuse holder and 
spare fuse, Transport Stream connectors and serial port interface to communicate between the 
DM1010 and PC. 

Rear Panel Illustration 

 

Figure 7: DM1010 Rear  Panel 

Physical Rear Panel Connections 

100 - 240 VAC (+/- 10%) 50/60 Hz

Input
RF 54- 806 MHz IF

Output

Fuse: 2AT/250V (20mm)

Power

On

Off 45 Watts
Maximum

Made in U. S. A.

RF - 8VSB Demodulator

(50 ohm)

Constellation

44 MHz

IF
4 MHz
(50 ohm)

(50 ohm)
CH 7/8

ASI

CH 7/8

Z/Blank

Y/I

X/Q

SSI
310M

IF 44 MHz

RS-232

Ethernet

10/100
Base T

SPI

Communication

(50 ohm)

(75 ohm)
(75 ohm)

(75 ohm)

(50 ohm)

(50 ohm)

(High Z)

Transport Stream
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Section 5: Technical Information 
Introduction 

This section provides technical information about the DM1010 Precision Demodulator. 

Block Diagram 

 

Figure 8: DM1010 Block Diagram 
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Instrument Settings 

This section provides supplemental information that may be useful during set up and operation of a 
DM1010 DTV Demodulator. 

Minimum Loss Pad: 

At times a 75-ohm antenna will be used to feed off-air signals to the DM1010. In such cases a 75-ohm to 
50-ohm impedance converter is necessary to present the proper resistive impedances both to the 75-ohm 
source (the antenna) and the 50-ohm load (the DM1010.) These impedance converters are called 
“Minimum Loss Pads.” They are always built with a fixed conversion loss of 5.72 dB. “Min Loss Pads” may 
be purchase from several commercial connector or attenuator manufacturers. 

The DM1010 has an instrument set up option that automatically increases front panel readings by exactly 
5.72 dB. When this mode is selected, the reading on the LCD display and through the instrument’s 
associated software will read the signal power value at the 75-ohm end of the Min Loss Pad. 

 
 
When “Min. Loss Pad” is selected  (Yes), the power reading on the instrument and in WinDM Pro software 
is increased by +5.7dB. Also when this feature is selected, the  icon in the upper right of the screen 
appears.  This feature is designed to allow a user to insert an external 75-ohm to 50-ohm min. loss pad in 
series with a 75-ohm antenna. This matches impedance for both antenna and demodulator.  In this setting, 
the DM1010 will read signal power at the input to the Min Loss Pad.  

 

     Min. Loss Pad feature selected:               Min. Loss Pad feature unselected. 

 

     
 
 



 Section 5: System Setup & Operation 
  

DM1010 User Manual Page 5-3 

dBm versus dBuV: 

The accompanying Signal Level Conversion Table is provided to show the relationship between signal 
levels at the rear panel connector. Three different units of measure are compared: microvolts, dBuV and 
dBm. This table is valid for signals in a 50-ohm environment. 

SIGNAL LEVEL CONVERSION TABLE 

Vin @ 50ohms dBuV dBm 

   

3.16 uV 10 dBuV -97 dBm 

   

100 uV 40 dBuV -67 dBm 

   

7.07mV 77 dBuV -30 dBm 

   

31.6mV 90 dBuV -17 dBm 

   

223.6 mV 107 dBuV 0 dBm 

Offset Power Settings: 

The DM1010 has a setup feature to allow a user to display power readings with an offset value added to or 
subtracted from the incoming signal power. This feature is accessed from the LCD front panel “Instrument 
Settings” page. Go to Offset Pwr and select ON. Now move down to the Pwr Offset menu line and enter 
the value you would like the LCD read out to add/subtract from the actual signal power reading. The LCD 
reading will now include the offset value you have programmed into the instrument. This value can remain 
in the DM1010 and can be activated or deactivated from the Offset Pwr menu line simply by selecting ON 
or OFF respectively. 

This feature is useful when an operator is connecting the demodulator to a signal through a coaxial cable 
or an attenuator with a specific known amount of insertion loss. In these cases the DM1010 front panel 
signal level can be adjusted to directly read the power level before the attenuator or coax. 

Local or Remote Control 

Control of the instrument can only be assigned to only one source.  It can be the front panel, i.e. Local - 
LOC.  Or it can be either the RS-232 port or the Ethernet port i.e. Remote -  REM.  The control will go to 
whichever device grabs it first by initiating communication.  If there is no communication for several 
minutes control will revert back to the front panel.  When the instrument is turned on it defaults to Local 
control. 

When the DM1010 is being controlled remotely from the WinDM Pro Application, the letters in the upper 
left of the LCD screen will indicate REM (Remote control). In remote mode, most front panel controls are 
not active. When the front panel is active, the upper left portion of the screen will display the letters LOC 
(Local Control).   
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If the DM1010 is under remote control, it is possible to force the instrument back to local, or front panel, 
control using the following “Local Control” setting. 

 

The “Local Control” selection has been updated to display the words “Set Now.”  When the user selects 
“Set Now” the instrument will immediately be controlled by the front panel.  

 

IP Add. Assign: 

The DM1010 is shipped from the factory with its Network Interface set to DHCP for a dynamic IP address.  
When turned on, the DM1010 will query the network for a DHCP server.  If a DHCP server is found, it will 
assign the DM1010 a dynamic IP address. The DM1010 will use that dynamic IP address as long as the 
network connection is valid. If the network connection fails or the unit is turned off then turned back on, a 
new query will occur, it may be assigned the same IP address as before, or it may be assigned a new IP 
address.  Depending upon how your DHCP server lease time is configured, your DM1010 may or may not 
get the same IP address each time it is turned on. 

DM1010 Fixed IP Address Assignment 

If your network does not have a DHCP server, or if you want to guarantee the units IP address is always 
the same, the DM1010 will need to be configured to always use a fixed IP address. Your network 
administrator will assign an IP network address. 

If the terminology used in this document thus far is foreign to you, your network administrator should do 
this configuration. 

The IP address is a set of four 3-digit numbers separated by periods. 

Example IP address: 192.168.100.068 

A Subnet Mask is a similar set of four 3-digit numbers separated by periods. 

Example Sub Net Mask: 255.255.255.0 

The Default Gateway is also a set of four 3-digit numbers separated by periods. 

Example Default Gateway: 192.168.100.1 

The current IP address assigned to the DM1010 can be viewed by pushing the Front Panel “Select” button 
twice. This brings up the Status Screen. 
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A Status Screen Display similar to this one below will appear. 

 

After viewing this screen, push the Cancel button to go back to normal operation and LCD readings. 

An IP address can be changed by using the “Remote Settings” Menu.  Either a fixed IP address or a 
Network assigned IP address can be initiated from this Menu location. 

For example, to assign a Fixed IP address, navigate to the “Remote Settings” screen. It will look something 
like this: 

 

Use the Tune Knob and the Select button change the “IP Add. Assign” from “DHCP” to “Fixed.”  When this 
selection is made, and the Select button is pushed, a message stating “settings are being changed please 
standby” will appear. This will be followed by the return of the “Remote Settings” screen. The user will note 
the “Fixed IP Add” line has changed to clear text, that is, from italic to normal type. Now the operator can 
enter the desired Fixed IP address. When this is complete and the Select button is pushed once again, the 
LCD readout will repeat the message “settings are being changed please standby.”  Wait for this process 
to be completed. 

The screen below shows a demodulator set for a Fixed IP Address. The actual address is indicated on this 
screen. 
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If desired, the instrument IP address assignment may be returned to the DHCP mode using the “IP Add. 
Assign” selection control area. 

Finally, the current active IP address can always be verified by navigating to the Status Screen. To do this, 
push the Select button two times.  This will bring up the Status Screen where the active “IP Address” is 
reported. See the Status Screen display shown earlier in this document. 

If there is any doubt that the new address has actually been set, turn the DM1010 off then back on.  The 
new IP Address will be shown in the Status screen of the DM1010 front panel. 
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Section 6: Options & Accessories 
Options 

ITEM DESCRIPTION 

Opt. XTS Delete Transport Stream hardware 

Opt. KCP Korean Channel plan 

Opt. TSR LVDS to USB 2.0 adapter and TSReader software.  Connect to PC to 
decode transports stream data.  Displays PAT, PMT, PID, contents, PID 
bandwidth usage, closed caption strings, video thumbnails.  Provides 
ETR290 stream monitoring. 

Standard Accessories 

QUANTITY DESCRIPTION 

1 User manual 

1 BNC female to N male adapter 

1 F female to BNC male adapter 

1 Power cord, 110VAC, US 

1 WinDM ProÔ  application CD 

1 Snag-It screen capture application CD 

1 Serial cable, 2 meter, 9 pin, male-female 

2 Rack Ears and hardware 

4 Desk top mounting feet, package of (4) and hardware 

Optional Accessories 

ITEM DESCRIPTION 

RS-1 One pair of rack slide rails, mounting hardware and installation 
instructions. For rack depths 18 to 24”. 

AV Audio/Video Receiver, IF input. 

EW-3 Extended Factory Warranty from standard 1 year to 2 years. 

C-3 Factory calibration at end of years 1, 2, and 3. Includes upgrade to 
current software version. 

TSR Includes TSReader Pro Software and LVDS to USB Module. Decodes 
Transport Stream for PID information and video. 
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Section 7: Zlink Command Reference 
Zlink Command Reference 

Commands can be sent from a terminal program to the DM1010 Demodulator to control and query the 
DM1010. Communications to the DM1010 can be either the Serial port or the Network port on the rear 
panel of the DM1010. Once communications are established, typing a question mark (?) followed by a 
carriage return will return the following list. This list consists of the command syntax and a list of 
commands. The values for each command are in square brackets [ ]. Each command is shown with a 
Q and/or S to indicate Query or Set. Some commands only query a setting while most will set and 
query a setting. Table 2.1 defines each command in more detail. 

Command Synt ax. . .  
: COMMAND[ ?] [ <SPACE>NewVal ue] <CARRAGE- RETURN> 
 
Commands . . .  
ATTEN ( Q/ S)  
    " : ATTEN [ 0, 10, 20, 30, 40, 50, 60 dB] "  
CHAN ( Q/ S)  
    " : CHAN"  
VERSI ON ( Q)  
    " : VERSI ON?"  
GAI N ( Q/ S)  
    " : GAI N [ Manual , Aut o] "  
GROUPNAME ( Q/ S)  
    " : GROUPNAME [ <$GROUPNAME>] "  
I FAMPG ( Q/ S)  
    " : I FAMPG [ 12, 18 dB] "  
I NPM ( Q/ S)  
    " : I NPM [ RF( channel ) , I F( 44MHz) , I nvr t d. I F( 44MHz) ] "  
I NSTNAME ( Q/ S)  
    " : I NSTNAME [ <$I NSTRUMENTNAME>] "  
I NSTI D ( Q/ S)  
    " : I NSTI D"  
LOCKS ( Q)  
    " : LOCKS?"  
MONCHAN ( Q/ S)  
    " : MONCHAN [ Ch7, Ch8] "  
MET ( Q)  
    " : MET?"  
NOTI FY ( Q/ S)  
    " : NOTI FY"  
RFAMP ( Q/ S)  
    " : RFAMP [ Of f , On] "  
SEREN ( Q/ S)  
    " : SEREN [ No, Yes] "  
SN ( Q)  
    " : SN?"  
SWE ( Q/ S)  
    " : SWE [ 10, 20, 40, 80 þs] "  
TAPS ( Q)  
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    " : TAPS?"  
TAPSWND ( Q/ S)  
    " : TAPSWND"  
TXS ( Q/ S)  
    " : TXS [ Of f , On] "  
WTAPS ( Q)  
    " : WTAPS?"  

1.1 ZLink Command Syntax. 

ZLink commands are formatted as follows 

:COMMand[?][<space><value>]<linefeed> 

In the command above the bold capitals, “:COMM”, represent required characters of the command. 
The non-bold small characters are ignored. 

Capitalization is not necessary and is shown here to highlight the difference between required and 
optional characters. Thus the follow commands are equivalent 

�COMM 
: COMMAND 
: command 
: comm 
 
Exampl es:  
: SER On 
: channel  40 
: agc manual  
: at t enuat i on 50 
: CHAN? 
: CHAN 20 
: TAPS? 
: GAI N Manual  
: ATTEN 60 
: RFAMP of f �
 

1.1 ZLink Command Responses 

The equipment will respond to every command in one of the following ways. 

1. When a command is successfully executed an event will be broadcast indicating the new change 
has taken place. 

2. If a command cannot be executed due to a syntax error a syntax error response will be returned. 

3. If a command cannot be executed because the equipment has disabled the command then a query 
only response will be returned. 

Summary of responses: 

<command> <value> 

ERROR SYNTAX <err#> “Unrecognized command ‘<command>’.” 

ERROR SYNTAX <err#> “Invalid value ‘<value>’ for command ‘<command>’.” 
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:ERROR QUERYONLY <err#> “The command ‘<command>’ can only be queried.” 

�

1.1.1. Respose to successful commands. 

The equipment will respond to successfully executed commands in the following format. 

Command sent: 

COMM <value> 

Response: 

COMM<space><new value><linefeed> 

Example: 

Command: 

Ser On 

Response: 

SER ON<linefeed> 

1.1.2. Error responses: 

The equipment will generate error response in the following general format. 

ERROR<space><error type><space><error number><space><error description><linefeed> 

See the following sections for specific examples of the various errors that can be generated. 

1.1.2.1. Syntax Errors: 

The equipment will respond to syntax errors in the following general format. 

ERROR SYNTAX <error number> <syntax error description> 

Syntax errors are categorized as follows 

A. Unrecognized commands occur when a command mnemonic is sent that is not contained in the 
catalog of commands 

B. Invalid values occur when an attempt to change an instrument is made using a value that can not 
be interpreted as valid for the given setting. 

1.1.2.1. A Unrecognized commands: 

Response: 

ERROR SYNTAX <error number> ”Unrecognized command ‘<command received>” <linefeed> 

Example: 
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Command: 

SEN ON 

Response: 

ERROR SYNTAX <unrecognized_command_error_number> “Unrecognized command ‘SEN’” 

1.1.2.1. B Invalid command value: 

Response: 

ERROR SYNTAX <invalid_value_error_number>”Invalid value ‘<value received>’ for command 
‘<command received>” <linefeed> 

Example: 

Command: 

SEN 2.4 

Response: 

ERROR SYNTAX <invalid_value_error_number>” “Invalid value ‘2.4’ for command ‘SEN’” 

1.1.2.2. Query Only Command Error. 

The equipment will respond to commands that are query only in the following format. 

ERROR QUERYONLY <error number> “The command ‘<command received> can only be queried.” 

Command sent while in local mode: 

SER ON 

Response: 

ERROR QUERYONLY <error number> “The command ‘SER’ can only be queried.” 

1.2. ZLink Command Separation 

Commands need to be separated with a <linefeed> character. This allows multiple commands to be 
sent to the equipment from a terminal that sends <linefeed> when the <Enter> key is pressed.  

1.2.1. Ignored Characters 

The ZLink protocol ignores characters in the following situation. 

The <Carriage Return> character (ASCII value 13) is ignored when immediately followed by a 
<Linefeed> (ASCII value 10). 

All characters after a <Linefeed> character and before a subsequent <Colon> character are ignored. 
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ZLink Command Responses 

2.1. Shared Menu/Remote Settings. 

This table shows the settings that can be modified from the menus and from remote control. The 
portions of the table with a grey background are not implemented at this time. 

Menu Name 
Setting Name 

Remote Command Values Units Query/Set Description 

Input Settings      

� � � � � � � � � � � � 	 �
 �� 
 � 
 �
 � �
 ��
 ���
 � 
 ��
 � �� �
� 	 � � �� 
 � � 
 � � 	 ��

Gain GAIN 
(Gain Control) 

Auto/Manual  Q/S Turns on / off auto gain control. 

Attenuation ATTEN 
(Attenuation) 

0,10,20,30,40,50,60  Q/S Sets the attenuation when in 
manual gain control. 

RF Amplifier RFAMP 
(RF Amp) 

On/Off  Q/S Turns on / off the RF amp when in 
manual gain control. 

IF Amp. Gain IFAMPG 
(IF Amp Gain) 

12,18 dB Q/S Sets the IF amplifier gain when in 
manual gain control. 

Tuning INPM RF(channel),IF(44MH
z) ,Invrtd.IF(44MHz) 

 Q/S Currently use of 44 MHz as RF 
input frequency. 

Channel Plan CHANP 
(Channel Plan) 

USA M, USA HRC, 
USA 2, Korea, 
”Custom Channel 
Plan Name” 

 Q/S Currently enabled channel plan 

Decoder Settings      

TStream TXS 
(Transport Stream) 

On/Off  Q/S Current state of transport stream. 

Taps Span SWE 
(Sweep) 

10,20,40,80 ms Q/S Current 8VSB decoder sweep size 
(approximate). 

SER Enabled  SEREN 
(Segment Error Rate 
Enabled) 

Yes/No  Q/S Turns on / off collection of 
segment error rate.   

Instrument Settings      

Front Panel Lockout FPL 
(Front Panel Locked) 

Locked/Unlocked  Q Current lockout state of front 
panel. 

Input Impedance MLP 
(Minimum Loss Pad) 

Yes/No W Q/S Signals the fact that an external 
75� � min. loss pad has been 
placed before the RF input. 

Power Units PWRU 
(Power Units) 

dBm, dBuV, [dBmV, 
dB] 

 Q/S Valid “Set” values are dBm or 
dBuv. 

Query will return all values. Query 
returns dBmV when min loss pad 
is enabled and always returns dB 
when power offset is enabled 
regardless of min loss pad setting. 

Offset Pwr. PWROFFEN 
(Power Offset 
Enabled) 

Yes/No  Q/S Enables the addition of a user 
defined power offset. 

Pwr. Offset PWROFF 
(Applied Power 

[-999.9, +999.9] dB Q/S User defined power offset for 
customizing displayed power. 
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Menu Name 
Setting Name 

Remote Command Values Units Query/Set Description 

Offset) 

Control CONTROL 
(Control Setting) 

Local/Free[/Remote]  Q Current state of remote control 
authorization. 

Monitor Channel MONCHAN 
(Monitor Output 
Channel) 

Ch7, Ch8  Q/S Current monitor output channel. 

Remote Settings      

RS232 Baud BAU 
(Baud Rate) 

4800, 9600,19K, 38K, 
56K 

Baud Q Current RS232 port baud rate. 

RS232 Flow FLO 
(Flow Control) 

None/Hardware  Q Current RS232 port flow control. 

DSR Enabled DTREN 
(DTR Enabled) 

Yes/No  Q Current IP address of the device. 

IP Address IPADD 
(IP Address) 

xxx.xxx.xxx.xxx  Q Current IP address of the device. 

Port IPPORT 
(IP Port) 

Port number less than 
65536. 

 Q Current IP port of the device. 

Group GROUPNAME 32 characters.  Q/S Queries/Sets the instruments 
group name. 

Name INSTNAME 
(Instrument Name) 

32 characters.  Q/S Queries/Sets the instruments 
name. 

Id Number INSTID 
(Instrument ID 
Number) 

32 bit number.  Q/S Queries/Sets the instruments id 
number. This can be used as an 
alternative to the Group 
name/Instrument Name pair. 

� NOTIFY 

(Auto Notification) 

TAPS=On/Off 

WTAPS=On/Off 

 

� � � � � Queries/Sets whether a 
notification is sent out the serial 
port(s) when changes occur to 
data. 

� CHAN 

(Channel) 

Any channel within 
the current channel 
plan. 

 Q/S Queries/Sets currently tuned 
channel. Displays “none” if in input 
mode is set to 44 MHz input. 

 SN  

(Serial Number) 

6 character serial 
number. 

 Q Instrument’s serial number. 

 VERSION 

(Firmware Version) 

Version formatted as 
x.x.x.x  

 Q Returns the version number of the 
currently loaded instrument 
firmware. 

 TAPSWND 

(Taps Window) 

Start(us), End(us)  Q/S Queries/Sets the window for 
WTAPS command. 

 WTAPS 

(Windowed Tap 
Values) 

Query only. Returns 
ASCII data formatted 
as shown below in 
Note H. 

 Q Returns the current set of N tap 
values for the current sweep 
setting which fall within the 
TAPSWND setting. 

 TAPS 

(Tap Values) 

Query only. Returns 
binary data formatted 
as shown below in 
note I. 

 Q Returns the current set of N tap 
values for the current sweep 
setting. 

 MET 

(Metrics) 

Query only. Returns 
binary data formatted 
as shown below. 

 Q Returns the current set of metrics 
such as SYNC Lock, EQ Lock, 
and RF Power in binary format. 
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2.1.1. Notes 

A. Commands in the above table are formatted with bold capitals representing the required characters and 
small-unbolded letters are optional characters. 

B. Remote Permissions are stated as Q or Q/S. ‘Q’  indicates query permission meaning the remote device can 
only query the current value of the setting. ‘S’  indicates the remote device can set (change) the current value 
of the setting. 

C. When IF Input is set to “On” , the channel setting will display “none”  and the main display will show “ IF 44 
MHz” . If a channel is set either via the menus or remotely, IF Input will automatically turn off and the 
channel will be set. The main display will then show “Ch XX” . 

D. The Remote Port setting controls the master remote communications connection. In the case the equipment 
will have both RS232 and Ethernet connections, one or the other connection will be given the status of 
control port. The other connection will be forced to a monitor only port. 

E. Baud and Flow control affect either the RS232 port or the Serial port connection depending on which port is 
active. 

F. The Input Impedance setting does not control the input impedance. It only allows the user to supply the fact 
that a impedance matching pad has been connected to the input. This allows the equipment to provide a 
calibrated power level that is accurate at the input of the impedance matching device. 

G. The Front Panel Lockout setting is used to lock the knobs and buttons of the front panel when in local mode. 
The lockout will allow the user only to enter the combination of buttons/knob manipulations to unlock the 
equipment. All other combinations are ignored. In other words, with the front panel locked while in local 
mode, the user can only navigate the menus to set the Front Panel Lockout setting to unlocked. 

H. The WTAPS query returns ASCII tap values in the following format… 
:WTAPS MainTapValue, NumberOfTaps, Tap1,Tap2,Tap3.,…,TapN<CARRAGE-RETURN> 
Each tap value is a raw (unnormalized) value. 

I. The TAPS query returns all tap values for the current sweep (SWE) setting the following format… 
:TAPS PageNumber , MainTapValue, Total.Num.Of.Taps:HighByte, ,Total.Num.Of.Taps:LowByte 
Num.Of.TapsForThisPage,Tap1,Tap2,Tap3.,…,TapN<CARRAGE-RETURN> 
Each tap value is a raw (unnormalized) value 
.



 
  

DM1010 User Manual Page 8-1 

Section 8: Glossary 
Glossary 

EQ Equalizer 

LO Local Oscillator 

AGC Automatic Gain Control 

TOV Threshold Of Visibility 

IF Intermediate Frequency 

RF Radio Frequency 

SNR Signal to Noise Ratio 

MSE Mean Square Energy 

SER Segment Error Rate 

ASI Asynchronous Serial Interface 

SSI Synchronous Serial Interface 

SPI Synchronous Parallel Interface 

LVDS Low Voltage Differential Signal 

PLL Phase Lock Loop 

VCO Voltage Controlled Oscillator 

BPF Band Pass Filter 

LPF Low Pass Filter 

HPF High Pass Filter 

NBF Narrow Band Filter 
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Section 9: SPI Connector Pin-Out 
Transport Stream SPI Connector Pin-Out 

The interface uses the 25 contact type D subminiature connector specified in ISO Document 2110 
(1989), with the contact assignment shown in table 1. 

Connectors are locked together with a screw lock, with a male screw on the cable connector and 
female-threaded posts on the equipment connector. The threads are of type UNC 4-40. Cable 
connectors employ pin contacts and equipment connectors employ socket contacts. Shielding of the 
interconnecting cable and its connectors must be employed. 

 

Table 1 - Pin Assignment 

Pin Signal line Pin Signal line 

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

13 

Clock A 

System Gnd 

Data 7 A (MSB) 

Data 6 A 

Data 5 A 

Data 4 A 

Data 3 A 

Data 2 A 

Data 1 A 

Data 0 A 

DVALID A 

PSYNC A 

Cable Shield 

14 

15 

16 

17 

18 

19 

20 

21 

22 

23 

24 

25 

Clock B 

System Gnd 

Data 7 B 

Data 6 B 

Data 5 B 

Data 4 B 

Data 3 B 

Data 2 B 

Data 1 B 

Data 0 B 

DVALID B 

PSYNC B 

 


